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CHAPTER 1 Planning Your PowerDesigner
Installation

The deployment of PowerDesigner® typically involves the installation of a license server, one
or more repository components, and a number of client machines.

A PowerDesigner environment can contain the following servers, components, and client
machines:
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» The PowerDesigner repository server components are commonly installed on a single
server:
« Repository Database - Required if using the repository.
» Proxy Server (Windows only) - Required if using the repository proxy.
* SySAM Server - Required if using served or floating licenses.
» Portal Server - Required if using the PowerDesigner Portal.
These components can, alternately, be installed on separate servers, to make use of an
existing database server, or to spread the processor load to maximize performance:
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CHAPTER 1: Planning Your PowerDesigner Installation

ﬁ Database Server

JOBC

=

Repasitory Database

Prowxy Server

Local servers - PowerDesigner can connect to these servers in your local environment:

« LDAP Server - to delegate the authentication of repository users.

e SMTP Server - to automate the sending of email notifications.

Client machines - Allow users to access the repository using the following applications:

» PowerDesigner Client - Can access the repository directly or through the proxy.
PowerDesigner can be installed on standard Windows machines or accessed via a
virtual machine or from a central server location. Clients at remote sites are
recommended to use a proxy connection.

« Web Browser - Can access the repository through the PowerDesigner Portal.

Note: For installation of PowerDesigner without a repository, perform steps one and two of
this procedure and then go directly to Chapter 2, Installing PowerDesigner on page 11.

1

Obtain your license key file (see Obtaining a License on page 4).

If you do not have a license key, you will only be able to install PowerDesigner for a 15-day
trial period.

Install the Sysam license server (see /nstalling a License Serveron page 5).

The license server is required if you intend to share served licenses among users instead of
assigning individual licenses per machine.

Install PowerDesigner on the administrator's workstation (see Chapter 2, Installing
PowerDesigneron page 11).

This initial installation is needed to install the PowerDesigner repository, which is used to
store and share models.

[optional] Install the repository to the administrator's workstation for testing and
experimentation (see /nstalling a Local Test Repository on page 24).

Choose a server capable of supporting large, long-running transactions to host your
repository. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on your DBMS, the number of concurrent users,
and the size of your repository.

Note: To calculate the size required for your repository database, estimate the number of
models that will be stored and the period during which they will be developed. An average
model containing 100 primary objects (tables, classes, etc.) will have an initial disk size of
5MB and the size of its initial check in will be around 10MB. Assuming an average number
of edits, each subsequent check in will add 10% to the size of the file, so that after an

average development period of two months (40 working days) with one check in per day,
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CHAPTER 1: Planning Your PowerDesigner Installation

the final model file size will be 10MB*1 . 140 or approximately 500MB. If your team will
develop 20 such models during the course of the year, you should allow 10GB of space for
your repository database.

If you want to use the repository proxy or PowerDesigner Portal, you should install them,
by preference, on the same machine where the repository is located to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing these
components on another machine on the same LAN segment.

6. Install SQL Anywhere® on the repository server, create a database to house the
PowerDesigner repository (see /nstalling and Authenticating SQL Anywhere on page
25), and create a service to run the database (see Running the Database as a Service on
page 27).

Alternatively, select or create a database using one of the other supported DBMSs:
» Adaptive Server® Enterprise
» Oracle 8 and higher
< IBM DB2 Common Server and DB2 for OS/390
* Informix 2000
* Microsoft SQL Server 2005 and higher - we recommend that you
use a server that is not currently managing a high transaction load,

since PowerDesigner performs long- running synchronous transactions during Check-
In/Check-Out.

Note: The most up-to-date list of supported DBMSs, is available at Azp.//
certification.sybase.com.

7. Install the repository to the new database (see /nstalling the Repository to the Serveron
page 28).

8. [optional] Install the repository proxy on the repository server (see Chapter 4, Installing
the Repository Proxy on page 37).

The proxy simplifies and offers more security for connection to your repository and may
provide performance improvements in environments where clients will be connecting
over a WAN or complicated LAN or when dealing regularly with large (15MB+) models.

9. [optional] Install the PowerDesigner Portal on the repository server (see Chapter 5,
Installing the PowerDesigner Portal Serveron page 39).

The PowerDesigner Portal provides access to your repository models via a Web browser.

10. Define a password policy, optionally connect to an LDAP server to delegate the
authentication of repository users and an SMTP server for notifications, and create groups
and user accounts with appropriate rights and permissions to control access to the
repository (see Core Features Guide > Administering PowerDesigner > Controlling
Repository Access).

11. [optional] Customize the PowerDesigner interface to optimize it for various groups of
users and define shared reference models and resources:
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CHAPTER 1: Planning Your PowerDesigner Installation

« Prepare profiles to customize the PowerDesigner interface (by hiding types of models,
objects, and properties and customizing menus, toolbars, and settings) and associate
them with appropriate users and groups (see Core Features Guide > Administering
PowerDesigner > Customizing the PowerDesigner Interface).

» Prepare shared reference models and an enterprise glossary for deployment to users
(see Core Features Guide > Administering PowerDesigner > Deploying an Enterprise
Glossary and Library).

« Prepare custom resource files (such as DBMSs, languages, and extensions) for
deployment to users (see Core Features Guide > Administering PowerDesigner >
Deploying an Enterprise Glossary and Library > Deploying an Enterprise Library >
Sharing Resource Files via the Library).

12. Install PowerDesigner on user machines (see Chapter 2, Installing PowerDesigneron page
11).

Note: If you are not using the repository proxy, you will also need to install the SQL
Anywhere client (as part of the PowerDesigner installation) or an appropriate client or
driver for your chosen DBMS on all client machines to allow them to connect to the
repository.

Obtaining a License

When you purchase SySAM 2-enabled Sybase® products, you must generate, download, and
deploy SySAM product licenses.

« If you purchased your product from Sybase or an authorized Sybase reseller, go to the
secure Sybase Product Download Center (SPDC) at Attps.//sybase.subscribenet.com and
log in to generate license keys. The license generation process may vary slightly,
depending on whether you ordered directly from Sybase or from a Sybase reseller.

« If you ordered your product under an SAP® contract and were directed to download from
SAP Service Marketplace (SMP), you can use SMP at http.//service.sap.com/licensekeys
to generate license keys for Sybase products that use SySAM 2-based licenses.

Host ID

To obtain a license, you must know the Aost /D and name of the computer that will act as the
license server. You can obtain these values during installation of SYSAM on the third page of
the installation program where you are asked to load or copy a license file to proceed. Ethernet
addresses are 12 character hex values consisting of digits 0 through 9 and characters A through
F, which can be entered in any of the following formats:

« 12AB34CD56EF
e 12-AB-34-CD-56-EF
e 12:AB:34:CD:56:EF

Your host id is obtained by entering the first 8 characters of the ethernet address in one of the
following formats:

4 PowerDesigner
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« 12AB34CD
» 12AB-34CD

Note: For some platforms, host IDs can also be entered in decimal formats, with a # prefix.
Example: #1039716963

For Windows platforms, if your machine does not have a network adapter, you can use the disk
serial number as an alternate host ID. Use the 1mutil Ilmhostid -vsn command or
execute DIR C: to obtain the serial number, remove the hyphen and enter it with a

DISK SERIAL NUM= prefix. For example: DISK_SERIAL_NUM=3e2e17fd

Installing a License Server

If you intend to use standalone served or floating served licenses, you must either install the
SySAM license server provided as part of the PowerDesigner installation or locate an existing
SySAM license server on your network, to which your PowerDesigner licenses can be
assigned.

The license server serves a license to a user upon request and retrieves it when it is no longer
being used. If all the licenses are already in use, the license server informs you that no license
is available.

You must already have obtained a license file before you can install the license server (see
Obtaining a License on page 4).

Note: Do not install a license server and PowerDesigner on the same workstation. License
servers installed with PowerDesigner v11 are not compatible with v12.0 and higher. If you no
longer use PowerDesigner v11, we recommend that you uninstall the old license server.

If you borrow a mobile license and your workstation has installed other products with FlexIm
served licenses, you may encounter problems returning your license to the server.

1. Selectthe machine on which you want to install the SySAM license server (this should not
be a workstation on which you will install any Sybase product), and insert the
PowerDesigner CD.

2. Clickthe Install Licenses Server button to open the Sybase Software Asset Management
Installshield wizard:
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CHAPTER 1: Planning Your PowerDesigner Installation

Sybase Software Asset Management 2.2 - Installshield Wizard

Sybase Asset Management 2.2

‘Welcome to the InstallShield Wizard for Sybase Sof Asset M g t 2.2
I The InstallShield wizard will install Sybase Software Asset Management 2.2 on your computer. To
contitue, click Nest.

Cancel

SYBASE  ~E7 e

3. Click Next to display the license agreement page. Read the License Agreement and click
the | Agreeradio button to accept the terms of the agreement. If you click | Do Not Agree,
the installation will be cancelled.

4. Click Next to display the license file definition page. Click the L oad button and browse to
the folder where your license file is located. The content of the license file is automatically
displayed in the License key box.

If you do not have a license file, see Obtaining a License on page 4.
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CHAPTER 1: Planning Your PowerDesigner Installation

Sybase Software Asset Management 2.2 - Installshield Wizard

Sybase® Asset Management 2.2

To continue, you must provide a valid license key.
Taload a license key from a lic file, click the Load button: Load...

If you have not already received a licenze key file [ lic), then you zan obtain it from the Sybaze
download site, and copy it into the license key field below. For further information about how to
obtain your licenze key, refer to pour purchasze documentation, or contact your local Subase
representative.

Hoszt ID: |DD13?23A1884 Computer Narne: |DBALEN-><P

I You will need to provide host 1D and computer name for downloading the licenze key file.

License Key:

#HSybasze Software Asset Management License File, FL License for PowerDesigner -
#5tudio E nterprize for wWindows
SERVER PHOEOS 000000000000
VEMDOR SYBASE
USE_SERVER
PACKAGE PD_STUE SYBASE COMPOMEMTS="FD_SHELL PD_CDM PD_LDM PD_PDM &
PD_0OM PD_ILM PD_BFM PD_ROM FD_FRM PD_<5M PD_MTHM PD_RMG
PD_FRJ %
PD_EAM PD_lAM PD_GLM" OPTIONS=SUITE SUPERSEDE &
15SUED=14-0ct-2010 SIGN2="07FB 535F FAES A345 09CD 7048 BE71 4
FDEE 4A9E OC7E FBOS 94A5 AB4S 77AE AJEF 04FA BEAT BCHA DGBE Y
0BFZ2 537C 8B01 631E ABC4 5340 DOAG B2DE D034 5111 0ATE" LI

5. Click Next to display the destination folder page. Select the suggested installation
directory or browse to a new one and then click Next to go to the settings page.

6. Click Next to accept the current settings and start copying files.

The copy starts. A progress box is displayed and Setup copies files to the destination
directory. When installation is complete:

* If SySAM had to be installed, you can choose to start the license server as a service.

« If the PowerDesigner licenses were assigned to an existing license server, you can
choose to reread the licenses to refresh the server license file.

7. Click Finish to exit the wizard.

Note: If a firewall is activated on the computer where the license server is installed, then
the ports 27000 and 2701 0 must be opened in the firewall. For a Windows Firewall, you
may need to add the port 27000 and the SySAM executable (for example C: \Sybase
\SYSAM-2 1\Bin\SYBASE.exe to the list of exceptions.

Additionally, on Windows and UNIX platforms, edit the license server license files to add
the port number 27000 to the line beginning SERVER and add a new line VENDOR

SYBASE PORT=27010 directly after it. When you have finished, these lines should read
as follows:
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CHAPTER 1: Planning Your PowerDesigner Installation

SERVER server name server id 27000
VENDOR SYBASE PORT=27010

Serving SAP Named User Licenses

Named User licenses are floating licenses that are served by SySAM and allow a specific
person to use PowerDesigner on any computer where it is installed. You must create a special
SySAM option file to correctly assign Named User licenses.

1. Create a new text file with the name SYBASE . opt inthe SYSAM-2 0O\licenses
directory and enter your Named User license information using the following format:

GROUP GroupName Member [Member...]
INCLUDE PackageCode GROUP GroupName [GroupName...]

The following parameters are available:

Parameter

Description

GroupName

Specifies the name by which you will identify a group of users who should
have access to the same PowerDesigner package.

Member

Specifies the login name (without any domain) of the user to whom the
Named User license is assigned. To assign multiple users, separate their
names with spaces.

PackageCode

Specifies the PowerDesigner package to which the group is assigned. The
following codes are permitted:

PD_EAR - PowerDesigner EnterpriseArchitect with Repository
PD_IAR - PowerDesigner InformationArchitect with Repository
PD_DMR - PowerDesigner DataModeler with Repository
PD_DM - PowerDesigner DataModeler

For example:

GROUP EnterpriseUsers Jane Bill Harry
GROUP DataUsersA Phil Jack Sally

GROUP DataUsersB James Thomas Percy
INCLUDE PD EAR GROUP EnterpriseUsers
INCLUDE PD DMR GROUP DataUsersA DataUsersB

2. Save the file and then restart the SySAM license server to enable it.
The Named User licenses are now available for use.

Note: Users to whom a Named User license have been assigned should select the Floating
License option when installing PowerDesigner or using the License Management Wizard.
SySAM detects the user's login name and serves the license accordingly.

PowerDesigner



CHAPTER 1: Planning Your PowerDesigner Installation

Adding Additional Licenses with Imtools

The license server should configure itself correctly at installation. If you need to subsequently
add additional licenses or otherwise administer the server, you can do so using Imtools.exe

1. Double-click SY SAM-x_x\Bin\Imtools.exe to open the LMTOOLS dialog.
2. Onthe Service/License Filetab, select SYSAM in the list of servers:

LMTOOLS by Macrovizion Corporation http: //www_macrovizion.com
File Edit Mode Help

Semvice/License File IS_I,Istem Settings | Utiities | Start/Stap/Reread | Server Status | Server Diags | Canfig Services | Bonowing |

Services allow FLE*net Servers to run in the background.

— Server List
€ Corfiguration using License File

& Configuration using Services

[~ LMTOOLS ignores license file path environment vaniables

3. Click the Start/Stop/Reread tab and click the Reread License File button to force the
server to read again the file sybpdes.lic and update license number.

4. Select File> Exit to close the LMTOOLS dialog.

For detailed information about Imtools, follow the SySAM Documentation Collection link
available at http.//www.sybase.com/sysam.

Troubleshooting with Imutil
Imutil.exe, which is available in the SYSAM-x x\Bin folder provides various diagnostic
possibilities.

For example, the following command can be used to find the user(s) who have currently
borrowed the license(s):

Imutil Imstat -a -c <port>@<host> where <port> and <host> are license
server information.

For detailed information about Imutil, follow the SySAM Documentation Collection link
available at htto.//www.sybase.com/sysam.

Installation Guide 9
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SySAM for IPv6 Environments

By default, the 32-bit Windows version of SySAM for IPv4 is provided in the PowerDesigner
setup. You can add IPv6 support easily after installation by copying the appropriate
executables in the installation directory.

1. Open SYSAM-x x\Bin\lmtools.exe and click the Start/Stop/Reread tab.

2. Selectthe sysamserverinthe listand click Stop Server (you may need to select the Force
Server Shutdown check box if licenses are currently being borrowed).

3. Open the folder SYSAM-x x\Bin\binIPv6, and copy the files lmgrd.exe and
SYBASE.exe t0 SYSAM-x x\Bin, overwriting the existing versions.

4. Return to the Start/Stop/Reread tab in the LMTOOLS dialog, and click Start Server.

SySAM for 64-Bit and Non-Windows Environments

You can obtain a SySAM server for 64-bit Windows or for a non-Windows environment from
the Sybase website.

Note: The 32-bit version of SySAM will run on a 64-bit Windows machine, but if you prefer to
install a 64-bit version, you can download it from the Sybase website.

To download a 64-bit version of SySAM for Windows or a SySAM server for a non-Windows
environment, go to Attp.//www.sybase.com/sysam, select SySAM Standalone License
Servers, and follow the download instructions.

Note: Any licenses that have been activated for a Windows server must be reactivated for any
other platform.

Windows 64-Bit Support

PowerDesigner is only available in a 32-bit version, but installation on 64-bit versions of
Windows is supported.

To ensure that PowerDesigner can communicate with your data sources, you should use the
32-bit version of the ODBC Administrator tool. PowerDesigner cannot connect to 64-bit
ODBC DSNSs. For detailed information about working with 32-bit DSNs on a 64-bit version of
Windows, see http.//support. microsoft.com/kb/942976.
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CHAPTER 2 Installing PowerDesigner

You can install PowerDesigner directly on individual client machines, including as a plugin
for the Eclipse and Visual Studio IDEs. You can also perform a mass silent installation or an
administrative installation to a network server.

Note: You should obtain a license key (see Obtaining a Licenseon page 4) and, if appropriate,
install and configure your license server (see /nstalling a License Serveron page 5) before
beginning.

PowerDesigner has the following minimum system requirements:

« Microsoft Windows XP, Vista, 7, or 8 or Microsoft Windows Server 2003 or 2008

e 1.5 GHz processor

e 2GBRAM

e SVGA or higher-resolution graphics adapter and compatible color monitor (800x600)
e CD-ROM drive

« 1GB disk space for installation of all the core modules (and demonstration videos).

For information about the frameworks and libraries and frameworks required by
PowerDesigner, see PowerDesigner Dependencies on page 20.

Note: Non-Administrator users may receive a warning message during installation as setup
requires write access on certain directories and on the registry that they may not have. Setup
can go on despite this message.

1. Insert the PowerDesigner CD-ROM in your drive.

If setup does not automatically start, then double-click the SETUP.EXE file in the setup
directory of the CD-ROM.

2. Click the Install Power Designer 16.5 button to open the welcome page, and then click
Next to go to the license selection page.

3. Select one of the following license types:

e Trial version—is a full-featured version, valid for an evaluation period of 15 days, that
allows you to perform any design task. Contact Sybase if you require a limited
extension.

» Local standalone license - is installed on and locked to a particular machine. Click
Next to go to the license key page, where you must load a valid license file (see
Obtaining a License on page 4).

»  Served standalone license— is provided by one or more SySAM license servers, and is
locked to a particular machine. Click Next to go to the license server page, where you
must enter the name of your license server.

Installation Guide 11



CHAPTER 2: Installing PowerDesigner

» Served floating license — is provided by one or more SySAM license servers, which
manage the allocation and recuperation of licenses among a pool of users. Click Next
to go to the license server page, where you must enter the name of your license server.

For more information about PowerDesigner licensing, see Core Features Guide >
Modeling with PowerDesigner > Getting Started with PowerDesigner > License
Management.

. [for served licenses] Click Next to go to the package selection page, where you can select

which package to install. The list displays all the packages that are available on the server
but it does not necessarily reflect the current availability of a license for a particular
package.

. Click Next to go to the license agreement page. Select the location where you are installing

the software, read the License Agreement, and then click the | Agreeradio button to accept
the terms of the agreement. If you click | DoNot Agree, you cannot proceed with the Setup
program.

Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

. Click Next to go to the directory selection page. Accept the default installation directory or

choose another by clicking the Browse button.

We recommend that you do not install a new major version of PowerDesigner in a
directory that holds a previous version.

. Click Next to go to the component selection page, which lists the products and features

that are available to install. Each node can be expanded in order to let you select or deselect
sub-features:

12
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=
Sybase’ PowerDesigner 16.5

Sybase PowerDesigner 16.5

Select the features you want to install. and clear the features you do not want ta install

1o def Descriptior

Conceptual D ata Madel A business process m_odel
E rterprise: Architecture Model [BPM] helps you identify.
Data Movement Madel des_cnbe, and decompose
N buginess processes. You can
Logical Data Model analyze pour system at various
Object-COriented Model levels of detail, and focus
hysical Data Model alkernatively ot contral fow (the
miect sequence of execution] or data
! X flow [the exchange of data).
Requirements Model “ou zan use BPEL, BPMN,
#ML Model and many other process
Repositomy languages.
General Add-ins
DF Documentation
utorial videos
Eclipse 3 Plug-in
SOL Anywhere 12 Drivers

Space Requiredon [ 1062560 K
Space Available on 40346616 K

Note:

» The PowerDesigner plugin for Eclipse is available for Eclipse v3.2 to v3.6. For more
information, see Core Features Guide > Modeling with PowerDesigner > The
PowerDesigner Plugin for Eclipse.

« The PowerDesigner add-in for Microsoft Visual Studio and Team Foundation is
available for Visual Studio 2005, 2008, and 2010. For more information, see Core
Features Guide > Modeling with PowerDesigner > The PowerDesigner Ada-In for
Visual Studio.

e The SQL Anywhere drivers provide connectivity to a repository installed on SQL
Anywhere, which is bundled with PowerDesigner (see /nstalling and Authenticating
SQL Anywhere on page 25).

Select or clear check boxes as necessary, and then click Next.

8. If you selected the Eclipse 3 plug-in in the list of components, the Eclipse directory
selection page is displayed. Click the Browse button to specify a directory containing a
valid Eclipse installation.

Note: If you had manually installed the Eclipse plug-in in PowerDesigner version 10 or 11
and want to upgrade to version 16.x you have to remove the plug-in manually. To do so,
open the Eclipse directory, and remove any PowerDesigner-related folder under the
\configuration, \features, and \workspace\.metadata\.plugins folders.

Installation Guide 13



CHAPTER 2: Installing PowerDesigner

9. Click Next to go to the user profiles page. Select the user profiles that you want to apply

immediately to your installation.

Note that whatever you select on this page, all the profiles will be installed and you can
apply any profiles after installation. If you select two or more contradictory profiles (for
example, E/R Notation and Barker Notation, in the CDM category), the one that appears

last in the list will be applied:

Sybase PowerDesigner 16.5

Sybase® PowerDesigner 16.5

The following uzer profiles will be installed. Select thoze that pou want to apply now. You can
always apply additional profiles later, from within PowerD esigner.

ral

Mo shaortcut property sheet
Dizplay Preferences
..[w] Cald Theme [blue, purple...]

v| Founded comers

- E/R Motation

- IDEF1 Motation

- Merize Matation

- Barker Notation

- E/R Motation

- IDEFT Matation

- Barker Motation

- Codaspl Motation

- Conceptual Motation
- IDEFT Matation
-[w] PDM - Relational Matation

[+ Authorize Framework Design

ot Theme [brown, orange...)

SYBASE ~t7ew | o=

Hest >

=)

Descriptior

Canecel

For more information about user profiles, including how to make your own profiles
available to the installer, see Core Features Guide > Modeling with PowerDesigner >

Customizing Your Modeling Environment > User Profiles.

10. Click Next to go to the program folders page. You can select to make PowerDesigner

available from the default folder or select or create another.

11. Click Next to go to the current settings page, which lists all your selections. Select the
K eep Power Designer Settingscheck box to retain any settings from a previous version of

PowerDesigner.

Note: For new major versions, even if you select to retain settings from a previous version,
resource file named paths (such as _DBMS) pointing inside the Resource Files
directory inside the PowerDesigner installation will be updated to point to the new
installation directory in order for you to benefit from bug fixes and other improvements. If
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you have defined additional paths for populating your resource file lists, these will not be
affected.

Sybase PowerDesigner 16.5 @

Sybase@ PowerDesigner 16.5

Setup has enough information to start copying the program files. [f you want to review or change
any gettings, click Back. |f you are zatizfied with the zettings, click Mext to begin copying files.

Current S ettings:

License Type:  Standalone Seat - Served -
Server  coolthing

TCP Port number: 27000

License Package:  Enterprisedrchitect

I Destination directony:  C:\Program Files\Sybaseh PowerD esigner 16

m

Program Folder:  Sybaze'\PowerDesigner 16

Eclipse 2.2 or superion,  D:h\eclipse_usheclipse

Uszer Profiles:
GeneralAuthorize Framework Design [Design Framework. upf]
GeneralsMo shortcut property sheet [NoS hortcut upf]
Digplay Preferences\Cold Theme [Blue, purple...] (Blue Theme.upf]
Display PreferencesHot Theme (brown, orange...] (Brown Theme.upf)
Display Preferences'Rounded comers [FoundCormer. upf]
Motation\COM - E/R Motation [COM E_R.upf]
Motation\COM - IDEF1 Motation [COM |defl = upf]
Motation\COk - Merize Motation [COM Merize. upf]
Motation\COM - Barker Motation [COMB arker.upf] -

Cancel

SYBASE ~tew | o

12. Click Next to begin the install. Setup begins copying files to the destination directory.

13. Wait for the setup to complete, and then click Finish to exit the wizard. Depending on your
working environment, you may be prompted to reboot your machine.

Note: The Readme . html file, which contains important release information, is
available in the root of your installation directory.

Installing PowerDesigner in Administrative Mode

System administrators can install PowerDesigner on a server and have client machines run the
application from this central install. The client machines do not install any files but their
registry is modified in order to be able to access PowerDesigner from the specified location.
With this type of install, there is only one instance of PowerDesigner to deploy and upgrade,
and you can choose any type of PowerDesigner license and combination of installation
options on each client machine.
1. Insert the CD-ROM in the drive to automatically launch the setup program. The initial
setup dialog box is displayed. Click the Administrative I nstallation button.

or
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Select Start > Run, type the PowerDesigner setup.exe path followed by /a in the Run
dialog box and click OK.

Run EHE

Type the name of a program, folder, document, or
Intermet resource, and Windows will open it Far yvou,

Qpen; I E:lSetupisetup.exe [a j

a4 I Cancel | Browse, ., |

The welcome page is displayed.
2. Click Next to display the network location page.

3. Specify the network location where you want to copy the product files, which must be
read-accessible to client machines, and then click I nstall.

You are not required to enter any product key or select any feature to install. All
PowerDesigner setup files are decompressed and copied to the server, but the server
registry and system files will not be affected. When this process is complete, the complete
page opens.

4. Click Finish to exit the InstallShield Wizard.

Installing Clients to Access the Administrative Installation

Once you have created the administrative install on the server, you can set up the client
machines. The client install is the same as the standard PowerDesigner install except that it
only modifies the client machine registry to reference the files located on the server and does
not copy any files, so that no space is required on the client machine.

Note: When installing many client machines with identical options, you may want to consider
silent installation (see /nstalling PowerDesigner in Silent Mode on page 17).

1. On the client machine, map a network drive to the server location containing the
administrative installation.

2. Open Windows Explorer, connect to the administrative installation location and double-
click the setup . exe file to display the Welcome page.

3. Click Next to open the license selection page, select a license type, and then click Next
again.

4. Select the appropriate installation parameters on the following pages, and then click
Finish to begin the install.

Depending on your working environment, Setup may ask you to reboot your machine.

16

PowerDesigner



CHAPTER 2: Installing PowerDesigner

Upgrading an Administrative Install
You can upgrade an administrative install with an EBF or minor version release downloaded
from the Web. You cannot upgrade between major versions. Each major version (12.x, 15.x,
etc.) must be installed as a new administrative install in its own directory.

The procedure is different for these two types of upgrade:

e EBFs - Unzip the zip file delivered with the msi over the existing administrative install.
* Minor releases - Run the upgrade executable with the following syntax:

powerdesignerver upd.exe /a

Installing PowerDesigner in Silent Mode

When deploying PowerDesigner on a large number of machines and using the same setup
options and destination folder for each machine, you can use the silent install mode, which
does not require user input, and uses a response file (setup.iss) to specify the required
installation options.

Note: You can perform a silent install from the product CD or from an administrative
installation on a network server (see /nstalling PowerDesigner in Administrative Mode on
page 15).

1. Tocreate asetup.iss response file, select Start > Run to open the Windows Run dialog and
enter the following command to open the PowerDesigner installer:

PD-inst-dir\setup\setup.exe /r /fl"path\setup.iss"

For example, the following command creates a response file in the Public folder of the
PDInstall server, which contains the PowerDesigner installation:

\\PDInstall\Public\setup\setup.exe /r /f1"\\PDInstall\Public
\setup\setup.iss"

2. Complete the installation parameters as required and then click Finish to create the
setup. iss file.

3. To launch asilent install on a client machine, run the following command either from the
client or via an administration tool:

PD-inst-dir\setup\setup.exe /s /fl"path\setup.iss" [/f2"path
\setup.log"]

If you do not specify a local path to the install log, then each silent install will overwrite the
content of the setup. 1og file in the central installation directory. To obtain
confirmation of a successful installation, open setup . 1og and search for the line
ResultCode=0.

For example, the following command installs PowerDesigner from the PDInstall server on
the client machine and writes a local log file to C: \ temp:
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\\PDInstall\Public\setup\setup.exe /s /f1"\\PDInstall\Public
\setup\setup.iss" [/f2"C:\temp\setup.log"]

Uninstalling PowerDesigner in Silent mode

Asilent uninstall works in a similar fashion to the silent install, but requires that you locate the
InstallShield PowerDesigner maintenance file.

For PowerDesigner v16.x this file is located, by default, at:

C:\Program Files\InstallShield Installation Information\{D88DF8F0-
B749-4D26-AFBC-A6E588099793} \setup.exe

Note: It may be that your maintenance file is not found in the standard location. You can
always retrieve its location file from the following registry key: HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft \Windows\Current\ersion\Uninstal\{ D88DF8F0-B749-4D26-
AFBC- A6E588099793}

1. To create an uninstall.iss response file, select Start > Run to open the Windows Run
dialog box to invoke the installshield maintenance file with the following options:

<path-to>\setup.exe /r /fl"<path>\uninstall.iss"

Complete the installation parameters as required and then click Finish to create the
uninstall.iss file at <path>. For example, the following:

C:\Program Files\InstallShield Installation Information
\setup.exe /r /fl1"C:\temp\uninstall.iss"

Uses the standard maintenance file, and creates uninstall.iss in a temp directory.
2. Proceed to uninstall the client machine with the following command:

<path-to>\setup.exe /s /fl"<path>\uninstall.iss"
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Uninstalling PowerDesigner and Installation Maintenance

After installing PowerDesigner on your machine, you can modify the installation by selecting
Control Panel > Add/Remove Programsor by restarting the installation.
Sybase PowerDesigner 16.5 @

Syba\ser"Ej PowerDesigner 16.5

Wwelcome ta the Sybaze PowerDesigner 16.5 Setup Maintenance program. Thiz program lets you
madify the current installation. Click one of the options below.

@ Select new program features to add or select cumently installed features to remaove.

I " Repair

Reinstall all program features installed by the previous setup.

" Bemaove

@ Remove all installed features.

You can:

*  Modify-your PowerDesigner installation by adding or removing program features. Select
or clear components in the components page.

»  Repair- your PowerDesigner installation by reinstalling it. You must have the installation
CD or access to the network drive where installation files are copied.

e Remove - your installation and clean up your registry.

Note: User files are not removed and you cannot modify your license configuration.
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Manual Fonts Installation

If setup fails to define default fonts, you can do it manually.

1. Select the Fonts page in the General Options dialog box and define fonts for Ul, Code and
RTF Editor.

2. Create a new report, select Report > Change Font and define new fonts.

3. Verify that the following registry key does not exist: HKEY_CURRENT_USER\Software
\Sybase\PowerDesigner 16\DisplayPreferences\Font Name.

4. Create a registry key named Font Name (with the following string values: Name, Size,
Style) for all symbols in the following registry key: HKEY_LOCAL_MACHINE
\Software\Sybase\PowerDesigner 16\DisplayPreferences\Font Name.

PowerDesigner Dependencies

PowerDesigner depends on a certain number of frameworks and libraries and will install them
if they are not present in your environment.

e WindowsInstaller-KB893803-v2-x86.exe - {0 support the installation
of .NET.

* Microsoft .NET Framework 4.0

*  Windows Installer 3.1 and Windows Imaging Component - for your Windows version.

e 02003pia.msi,02007pia.msi, 02010pia.msi - Microsoft Office Primary
Interop Assemblies for MS Office 2003, 2007, and 2010 to support PowerDesigner MS
Office plugins.

* extensibilityMSM.msi - shared Addin Extensibility update for .Net to support
PowerDesigner MS Office plugins.

e msxml6-KB954459-enu-x86.exe - to support the PowerDesigner XSM.

e vjredist.exe - Microsoft Visual J# 2.0 redistribuable to support the PowerDesigner
Auto-Layout feature.

e ProjectAggregator2.msi - to support the PowerDesigner Visual Studio add-in.

* vcredist x86.exe - Microsoft Visual C++ 2010 Runtime Libraries

Upgrading PowerDesigner

This topic provides guidance on issues relating to Office add-ins, the license server, and
resource files, which may arise when upgrading PowerDesigner.

» Repository branches - Prior to v16.1, the repository browser only supported displaying a
single branch at a time. When you upgrade an existing repository to v16.1 or higher, all
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branches will become, by default, visible for all users. You may wish to simplify viewing
the repository by deleting documents and branches that are no longer used, by using
permissions to hide certain branches from users or groups who have no need of them, or by
migrating active models to a new repository (see Post-Upgrade Cleanup for a Repository
Containing Branches on page 34).

« Office add-ins - Though PowerDesigner v15.x and v16.x can be installed together on the
same workstation, after the installation of v16.x, the add-ins supporting importing from
MS Word and Visio will only function for v16.x.

» License Server - In general, you can serve licenses for clients using PowerDesigner v15.x
and v16.x from the same SySAM license server. However, if you want to support
heterogeneous versions of the Data Architect package (which is only available as an
upgrade to v16.x and not as a new purchase), you will need to install a second license
server on another machine and plan to serve the licenses associated with each version from
a separate server.

* Resource Files - DBMS and language definition files and other resource files provided
with PowerDesigner are constantly evolving. If you have not edited the resource files
delivered with a previous version of PowerDesigner, then the upgrade to the latest version
will happen silently.

If you have edited a definition file or other resource file from a previous version, then it will
continue to work with the new version. However, we advise you to use the Comparetool
to review the differences between your file and the file delivered with the new version and,
if appropriate, merge them to obtain bug fixes or new features. For information about
comparing and merging resource files, see Customizing and Extending PowerDesigner >
PowerDesigner Resource Files.

If you have stored resource files from a previous version in the repository then you must
check them in again under the new version before you can continue to use them. Resource
files can now be stored in the library and pushed to users (see Core Features Guide >
Administering PowerDesigner > Deploying an Enterprise Glossary and Library >
Deploying an Enterprise Library > Sharing Resource Files via the Library).

Note: To comply with recent Microsoft recommendations, PowerDesigner no longer
allows you to save resource files inside the Program Files folder, and will propose an
alternative location if you try to do so, adding the selected directory to the list of paths for
that type of resource file. Resource files previously saved inside Program Files may
no longer be available, as Windows Vista or Windows 7 actually store them in a virtual
mirror at, for example, C: \Users\username\AppData\Local
\VirtualStore\Program Files\Sybase\PowerDesigner
16\Resource Files\DBMS. Torestore these filesto your lists, optionally move them
to a more convenient path, and add their location to your list using the Path tool.
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The PowerDesigner repository can be used to store your PowerDesigner models and other
files relating to your design projects. An administrator must set up the repository, which is
stored in a database on a server.

Note: Before installing the repository to a server, you may want to create a local install on the
administrator's workstation for testing and experimentation (see /nstalling a Local Test
Repository on page 24).

For information about using the repository, see Core Features Guide > Storing, Sharing and
Reporting on Models > The Repository.

1. Choose a server capable of supporting large, long-running transactions to host your
repository. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on your DBMS, the number of concurrent users,
and the size of your repository.

Note: To calculate the size required for your repository database, estimate the number of
models that will be stored and the period during which they will be developed. An average
model containing 100 primary objects (tables, classes, etc.) will have an initial disk size of
5MB and the size of its initial check in will be around 10MB. Assuming an average number
of edits, each subsequent check in will add 10% to the size of the file, so that after an
average development period of two months (40 working days) with one check in per day,
the final model file size will be 10MB*1 . 140 or approximately 500MB. If your team will
develop 20 such models during the course of the year, you should allow 10GB of space for
your repository database.

If you want to use the repository proxy or PowerDesigner Portal, you should install them,
by preference, on the same machine where the repository is located to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing these
components on another machine on the same LAN segment.

2. Install SQL Anywhere® on the repository server, create a database to house the
PowerDesigner repository (see /nstalling and Authenticating SQL Anywhere on page
25), and create a service to run the database (see Running the Database as a Service on
page 27).

Alternatively, select or create a database using one of the other supported DBMSs:
 Adaptive Server® Enterprise

» Oracle 8 and higher

* IBM DB2 Common Server and DB2 for OS/390

* Informix 2000
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e Microsoft SQL Server 2005 and higher - we recommend that you
use a server that is not currently managing a high transaction load,
since PowerDesigner performs long- running synchronous transactions during Check-
In/Check-Out.

Note: The most up-to-date list of supported DBMSs, is available at Attp.//
certification.sybase.com.

Install the repository to the new database (see /nstalling the Repository to the Serveron
page 28).

[optional] Install the repository proxy on the repository server (see Chapter 4, Installing
the Repository Proxy on page 37).

The proxy simplifies and offers more security for connection to your repository and may
provide performance improvements in environments where clients will be connecting
over a WAN or complicated LAN or when dealing regularly with large (15MB+) models.

[optional] Install the PowerDesigner Portal on the repository server (see Chapter 5,
Installing the PowerDesigner Portal Serveron page 39).

The PowerDesigner Portal provides access to your repository models via a Web browser.

Define a password policy, optionally connect to an LDAP server to delegate the
authentication of repository users and an SMTP server for notifications, and create groups
and user accounts with appropriate rights and permissions to control access to the
repository (see Core Features Guide > Administering PowerDesigner > Controlling
Repository Access).

Installing a Local Test Repository

Before deploying the repository to a database server in your production environment, you may
want to create a local install on the administrators workstation for testing and experimentation.

1

Install SQL Anywhere on your local machine (see /nstalling and Authenticating SQL

Anywhere on page 25), and create a database (see Creating a Database to Contain the

Repository on page 26).

Install PowerDesigner (see Chapter 2, Installing PowerDesigneron page 11).

Install the repository to the database (see /nstalling the Repository to the Serveron page

28).

[optional] Install the PowerDesigner Portal (see Chapter 5, Installing the PowerDesigner

Portal Serveron page 39).

Review the following sections for information about repository features and

administration:

»  Core Features Guide > Storing, Sharing and Reporting on Models > The Repository

e Core Features Guide > Storing, Sharing and Reporting on Models > The
PowerDesigner Portal
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e Core Features Guide > Modeling with PowerDesigner > The Browser > The Glossary
e Core Features Guide > Modeling with PowerDesigner > The Browser > The Library
e Core Features Guide > Administering PowerDesigner

Installing and Authenticating SQL Anywhere

The PowerDesigner repository is delivered with an authenticated version of Sybase SQL
Anywhere, which can only be used to store your PowerDesigner model repository. Note that
the trial version of PowerDesigner is supplied with a lighter version of SQL Anywhere, for
which the setup may be slightly different.

1. Insert the software CD-ROM in the drive, and click the Install SQL Anywher e button.
Choose your setup language, and then click Next to open the SQL Anywhere InstallShield
wizard.

Note: If you have downloaded a trial version of PowerDesigner from the Sybase website,
the authenticatedversion of SQL Anywhere is available for download from the same page.

2. Click Next to go to the license agreement page. Select your country or region, review and
accept the license terms, and then click Next to go to the Custom Setup.

3. Leave all the defaults, click Next, and then click I nstall to start the installation.

Note: When installing SQL Anywhere on a 64-bit version of Windows, you must install
the 32-bit versions of the database and administration tools (see Windows 64-Bit Support
on page 10).
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i'é'u SOL Anywhere 12 - InstallShield Wizard

Custom Setup

Select the program features you wank inskalled,

Click. on an icon in the lisk below bo change how a feature is installed.

i - Feature Lescription

Full set of available database
fFarmats.

<=0+ | SQL Anywhere For Windows Mohile

(=3 ~ | Administrakion Tools
b =50 | Samples

This Feature requires OKE on
wour hard drive, It has 2 of 2
subfeatures selected, The
subfeatures require 137MBE on
wour hard drive,

Install tao:
ZA\Program Files\agL Anywhere 12Y Change. .. |
Installshield

Help | Space | Mext = I Cancel |

4. When the installation is complete, you will be invited to view the ReadMe and online
resources. Make your choices, and then click Finish to exit the wizard

5. Copytheauthenticate.sql filedeliveredinthe Setup\ support directory of the
installation media (and installed to the Too1s directory of your PowerDesigner
installation) to the \Scripts directory in your SQL Anywhere installation on the
repository server.

Copying these statements in this way ensure that when you create a database, it will
automatically be authorized for use with the PowerDesigner repository.

Note: If you create a database before having copied the authentication instructions in this
way, then you will need to authenticate it manually by opening the Interactive SQL tool,
logging into your database, and running the contents of authenticate. sqgl against
it.

Creating a Database to Contain the Repository

Once you have installed SQL Anywhere, you must create an authenticated database on the
repository server to which you will deploy the repository.

1. Select Start > Programs> SQL Anywhere12>Admin Tools> Sybase Central to open
Sybase Central.

2. Select Tools > SQL Anywhere 12 > Create Database to open the Create Database
Wizard.
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Click Next to go to the Select a Location page. The Create a database on thiscomputer
option is automatically selected. Click Next to go to the Specify a Database File page.

Enter an appropriate name and location for the database, and then click Next to go to the
Specify the Transaction Log File page.

Note: You will need to specify this file when you create a data source to allow
PowerDesigner to connect to the database (see /nstalling a Local Test Repository on page
24).

Make sure the Maintain the Following Transaction L og File check box is selected,
accept or specify an alternate log file name and location, and then click Next.

Continue clicking Next and accepting the default settings until you arrive at the Specify
DBA User and Password page.

By default, the database is created with an administrator account called DBA, and with a
password sgl. Select these defaults or enter your own, and then click Next to go to the
Connect to the Database page.

Note: You will need to enter this username and password in the repository definition (see
Installing the Repository to the Serveron page 28) and data source (see /nstalling a Local
Test Repository on page 24).

Deselect the Connect to the new database option, and then click Finish to create the
database.

Running the Database as a Service

To make your repository database available to clients over the network, you should run it as a
service.

1

On the database server, select Start > Programs> SQL Anywhere 12 > Admin Tools>
Sybase Central to open Sybase Central.

If the Servicestab is not visible, double-click the SQL Anywhere entry on the Plug-instab
to show it.

Select the Servicestab, and then click the New Service tool to open the Create Service
Wizard, enter a name for the service and click Next.

Select Network Database Server and click Next.
Accept the default executable (dbsrv12.exe) and click Next.

Enter appropriate parameters separated by spaces or carriage returns and click Next. We
recommend that you enter as a minimum the following parameters:
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Parameter Description

-n servername dbfilepath [required] Specifies the server name and path to
the . db file. For example:

-n repository c:\db\repository.db

-x tcpip (port=portno) [recommended] Specifies the port to use. For ex-
ample:

-X tcpip (port=2638)

7. Click Next three times, accepting the remaining defaults, select Start the service now,
and then click Finish.

The database is now running and available to be connected to over the network (see
Creating a Data Source to Access the Database on page 30).

Installing the Repository to the Server

The repository administrator must set up the repository on a database server running one of the
supported DBMSs.

Note: Before installing the repository, you must have access to a database (see Creating a
Database to Contain the Repository on page 26) and have installed PowerDesigner on the
repository administrator's workstation (see Chapter 2, Installing PowerDesigneron page 11).
The database user you use to install the repository must have the right to create tables and other
objects. We recommend that you begin with an empty database.

1. Onthe repository administrator's workstation, start PowerDesigner and select Repository
> Repository Definitionsto open the List of Repository Definitions.

2. Clickthe Add a Row tool to create a new definition, and click the Propertiestool to open
its property sheet.

3. Enter the following properties:

Property Value

Repository name | Enter an appropriate name to identify the repository.

Data source Click the Select a Data Sour cetool to the right of the field and select or create
name the data source that you want to use to connect to the repository database.

To create an ODBC machine data source for a SQL Anywhere database, see
Creating a Data Source to Access the Database on page 30. For detailed
information about creating, configuring, and using connection profiles for
other DBMSs, see Core Features Guide > Modeling with PowerDesigner >
Getting Started with PowerDesigner > Connecting to a Database.

User name Enter the administrator name you chose when creating the database.
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Property Value

Password Enter the administrator password you chose when creating the database

Bytes per char For non-Oracle unicode or multi-byte character set databases, specify the
bytes per character used by the database:

e 1-byte - [default] For SBCS (Single-Byte Character Set)

e 2-byte - For DBCS (Double-Byte Character Set)

e 3-byte - For Unicode or MBCS (Multi-Byte Character Set)

4. Click Test to test the connection and, in the event of an error, double-check your
connection parameters. Then click OK to return to your repository definition, and click
OK to complete its creation.

5. Select Repository > Connect to open the Connect dialog. Select the name of the
repository definition you just created and click OK to connect.

A message box is displayed inviting you to install the repository. This will involve running
a SQL script to create the necessary tables.

6. Click Yesto continue. The read-only Repository Installation Script window opens.

_njx
Separator; I! VI
create table PMATTR ﬂ
[
ATTR int  not rull,
CLSS it not null,
DSID int ot null,

MAME  warchar[254] nat null,
CODE warchar[254] not null,
CTvP int ot null,

FLGS int  not null,

THAM varchar254]
CHaM  varchar[254)

create unigue index PMATTR_PK. on PMATTR [&TTR]

-
4| | »

Execute I Cancel |

Note: You cannot edit the script in this dialog, but you can, if necessary, modify the
statements (for example, to add physical options) by copying the script to an external SQL
editor, making the appropriate edits, and then connecting to the database to execute the
script outside of PowerDesigner. The Separator list in the dialog lets you select the
separator appropriate to your interpreter.

7. Click Executeto run the script and create the repository tables. This may take several
minutes.
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Note: If the installation fails due to network problems, insufficient disk space, or
permission problems, we recommend that you do not choose to ignore the errors, but rather
abort the installation and start again.

When the repository has been installed, the Change Password dialog will open, prompting
you to change the administrator password. Enter a password that complies with the default
repository password policy as listed in the dialog, and then click OK to complete the
creation of the repository.

In the repository Browser, the root of the repository tree displays the repository name and
the connected user and is ready for use.

Creating a Data Source to Access the Database

Client machines running PowerDesigner will require a data source to connect to your database
over the network.

The instructions given here are for creating an ODBC machine data source for SQL
Anywhere. For information about creating other data sources for other DBMSs, see Core
Features Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner >
Connecting to a Database.

Note: In order to create a data source on a Windows 7 machine, you may need to launch
PowerDesigner or the ODBC Data Source Administrator by right-clicking its icon or menu
item and selecting Run as administrator.

1

Click the Select a Data Sour ce tool on the Repository Definition dialog, then select
ODBC machine data source and click Configure. On the ODBC Machine Data
Sour cestab of the Configure Data Connections dialog, click the Add Data Sour ce tool,
then select System Data Source and click Next.

Alternately, to create a data source using the ODBC Data Source Administrator, select
Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC),
select the System DSN tab, and then click Add.

Note: Ina64-bitenvironment, you must use the 32-bit version of the ODBC Administrator
tool, because PowerDesigner cannot connect to 64-bit ODBC DSNs (see Windows 64-Bit
Supporton page 10).

Select SQL Anywhere 12 and click Next, and then click Finish to create the data source.

On the ODBC tab of the ODBC Configuration for SQL Anywhere dialog, enter an
appropriate name such as PD Repository in the Data source name field.

Click the Login tab and complete it as follows:

To connect to the repository running as a service on a database server (see Running the
Database as a Service on page 27), enter:
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Parameter Value

Authentication Select Database.

User ID Enter the administrator name you chose when creating the database (see
Creating a Database to Contain the Repository on page 26).

Password Enter the administrator password you chose when creating the database.

Action Select Connect to a running database on another
computer.

Host Enter the name of the database server.

Port Enter the port specified in the service definition. The default port is 2638.

Server name Enter the name of the server specified in the service definition

Database name Not required

To connect to a repository running locally for testing (see/nstalling a Local Test
Repository on page 24), enter:

Parameter Value

Authentication Select Database.

User ID Enter the administrator name you chose when creating the database (see
Creating a Database to Contain the Repository on page 26).

Password Enter the administrator password you chose when creating the database.

Action Select Start and connect to a database on this
computer.

Database file Browse to and select your database file.

Database name Enter an appropriate name such as PD Repository.

Server name Enter an appropriate name such as PD Repository.

Start line Enter "C:\Program Files\SQL Anywhere

12\Bin32\dbsrv12.exe" (including the quotation marks).

Stop database after | Deselect this option if you want the repository to continue to be available
last disconnect after you disconnect from it.

5. Click OK to complete the configuration of the data source.
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Troubleshooting the Repository Installed on ASE

This section lists known issues encountered when installing the repository on Sybase
Adaptive Server Enterprise.

Commonly Required ASE Parameters

The following ASE parameters must frequently be configured higher than their default
settings to optimize check in of models:

¢ number of open objects

¢ number of open indexes

¢ number of locks

L4 max memory

¢ procedure cache size

Must declare variable ‘@dr_t_a0'. SQLSTATE = 727777

If you see the above error and are connecting to an ASE server via ODBC, open the ODBC
Data Source Administrator, select your data source, and select the Enable Dynamic Prepare
option on the Connection tab.

Truncated data on extraction

If you are seeing data truncated on extraction from the repository and are connecting to an
ASE server via ODBC, open the ODBC Data Source Administrator, select your data source,
and enter the value 10000000 in the Text size field on the Advanced tab.

If characters such as the ellipsis are being truncated, you should verify that the character set of
your driver matches the setting for your database.

Connection Profile: "Error converting characters into server's character set"

If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
Definition dialog, add the CharSet parameter, and enter the appropriate charset value to
match your repository database.

Troubleshooting the Repository Installed on DB2

This section lists known issues encountered when installing the repository on IBM DB2.

Exception During Search

If you are seeing exceptions when performing a search through the PowerDesigner Portal, you
should consider doubling the size of the applheapsz parameter, which controls the
application heap size.

Connection Profile: "Error converting characters into server's character set"
If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
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Definition dialog, add the CharSet parameter, and enter the appropriate charset value to
match your repository database.

Troubleshooting the Repository Installed on SQL Server

This section lists known issues encountered when installing the repository on Microsoft SQL
Server v2005 and higher.

Optimizing Repository Reads with Snapshots
To ensure that all users reading data will get access to a snapshot and not be blocked by
concurrent transactions, we recommend that you enable the following SQL Server options:

e ALLOW_SNAPSHOT_ISOLATION
* READ_COMMITTED_SNAPSHOT

Note: No users should be connected to the repository when you enable these options.

Connection Profile: "Error converting characters into server's character set"

If you receive such a conversion error when working with a connection profile, click the
ellipsis button to the right of the Connection parameters field on the Connection Profile
Definition dialog, add the Charset parameter, and enter the appropriate charset value to
match your repository database.

Upgrading the Repository

When an administrator upgrades their PowerDesigner client and then connects to an existing
repository for the first time, they will be prompted to upgrade the repository. Until an
administrator upgrades the repository, other users who have upgraded their PowerDesigner
client will not be able to connect to the repository.

Warning! Always back up your repository database before upgrading it. Upgrading the
repository typically creates many log entries, and you should consider increasing the log size
to accommodate them.

1. If you have installed the PowerDesigner Portal, you must stop the PowerDesigner Portal
Service before upgrading the repository.

2. Open PowerDesigner and select Repository > Connect to open the Connect dialog.

Only the PowerDesigner modules that are installed on your machine will be upgraded in
the repository database. For example, if you do not have the Object Oriented Model
installed on your machine, that part of the repository database will not be upgraded. For
this reason, you should try to perform the upgrade from a machine that has all of the
modules used by your organization installed.

3. Select a direct repository definition from the list, enter your password, and click OK.
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Note: Upgrading the repository via the proxy is not supported.

4, You are prompted to update the repository. Click Yesto continue and open the Repository
Update Script dialog.

Depending on the size and complexity of your repository, this dialog may take several
minutes to appear.

Note: If you created your repository database with Microsoft SQL Server or Sybase ASE
before PowerDesigner version 15.0, we recommend that you select Rebuild clustered
indexesin this dialog to improve performance, particularly for document check out. If you
do not select this option at upgrade time, you can select Repository > Administration >
Rebuild Clustered Indexes at any time to perform the rebuild.

5. Click Executeto begin the repository upgrade.

The upgrade may take some time to complete. In the event of an upgrade failure due to
network or permission problems, or insufficient disk space, you should restore the
repository database from your backup version and retry an upgrade when problems are
solved. If the upgrade fails because of the data in your database, then you should contact
technical support for assistance.

6. [when upgrading fromarepository before v16.1] If your repository contains branches, you
are prompted to update your branches to the new implementation (see Post-Upgrade
Cleanup for a Repository Containing Branches on page 34). Click OK to continue.

Note: Depending on the complexity of your branch structure and the size of your
repository, upgrading your branches may take a considerable time. If you click Cancel at
this point you will leave the repository in a stable state, and can relaunch the upgrade at a
later point by reconnecting to the repository.

7. [when upgrading from a repository before v16.1] If your current password does not
comply with the default repository password policy, you will be prompted to change your
password. Enter your new password (which must comply with all the rules listed in the
dialog) and then click OK.

Note: Administrators can control the restrictiveness of the password policy (see Core
Features Guide > Administering PowerDesigner > Controlling Repository Access >
Defining a Password Policy).

8. The Library Synchronization dialog opens to prompt you to synchronize the contents of
your local library. Make any appropriate selections and click OK to perform the
synchronization and complete the repository upgrade.

For information about administering the library, see Core Features Guide > Administering
PowerDesigner > Deploying an Enterprise Glossary and Library.

Post-Upgrade Cleanup for a Repository Containing Branches

The new implementation of repository branches provides many improvements over branches
in v16.0 and earlier, but if your existing repository contained branches, you may want to
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perform some post-upgrade cleanup of your updated branch structure or create a new
repository and migrate all your active documents to it.

From version 16.1, branches in the repository have been completely re-architected to allow:

The simultaneous display of all branches in the repository browser.
Branching on a folder-by-folder basis.

Simplified version numbering.

Greater flexibility and control over branch contents.

Simplified integration of changes from one branch to another.

During the repository upgrade, PowerDesigner will transform any existing branches in your
repository to the new format, and your new repository will display all of your old branches as
siblings directly under the root. As a result, you may experience the following issues:

Too many branches at root making the repository difficult to view and navigate. To
simplify your repository, you should consider:

» Hiding branches when they are not needed for certain users.
« Deleting old branches that are no longer needed for any users.

Note: For information about working with the new repository branches, see Core Features
Guide > Storing, Sharing and Reporting on Models > The Repository > Branching Version
Trees.

The presence of branches at the root prevents you from being able to branch sub-folders
(because you cannot create a branch under another branch).

To simplify a repository and enable the creation of branches on a folder-by-folder basis, you
should create a new repository and transfer all your appropriate models and other documents
to it.

1

Review your existing repository and identify the models and other documents that are still
current and that you want to transfer to your new repository.

Create a new repository and create all the necessary users and groups in preparation for
allowing your users to connect to it.

Set up an appropriate folder structure to allow you to organize your documents by project,
and in preparation for future branching.

Connect to your old repository and check out all the documents you want to transfer.

Note: To ensure that no changes are lost, you may want to perform the remaining steps
outside of normal working hours or instruct your users to terminate their connections with
the old repository and await permission to begin connecting to the new repository.

Connect to your new repository and check the documents to transfer into it.

Note: When you check documents into the new repository, their revision histories will not
be transferred with them. For this reason, you may want to retain, at least for a time, your
old repository to give you continuing access to this information.
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6. Continue transferring documents until everything that you need for ongoing development
is in the new repository and organized in an appropriate folder structure.

7. Communicate the new repository connection information to your users and instruct them
from now on to only check documents in and out of the new repository.

Deleting the Repository

You can delete the repository by using the Drop Repository Tables command, which
removes all repository tables and their content from the database and cuts the connection with
the database. You cannot drop the repository tables through a proxy connection. You must
perform a direct ODBC connection instead.

War ning! Dropping the repository database cannot be undone. If you have not backed up your
models and other contents, they will be lost.

1. Select Repository > Administration > Drop Repository Tables. You will be prompted
to confirm that you want to continue. Click Yesto open the Repository Table Drop Script
window.

This window is read-only. You can only review the script, and not edit it. If you want to
modify the script you should copy it to a script interpreter, after having selected the
appropriate separator for your interpretor from the list.

2. Click Executeto begin the deletion.
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The PowerDesigner repository proxy is an optional program that runs as a service on or near
the repository server and translates SQL requests from client workstations into a more
efficient proprietary format. The proxy can considerably improve performance, particularly if
clients will be connecting over a WAN or complicated LAN environment or when dealing
regularly with larger (15MB+) models, due to its client request pooling and sophisticated
caching.

Using the proxy also simplifies the client connection to the repository, as users do not need to
know details of the database hosting the repository.

1

Choose whether to install the repository proxy on the repository server, or on another
windows machine on the same LAN.

You should install the proxy on the same server as the repository, if possible, to optimize
communication between the components. If the repository server is not a Windows server
or is unable to support the additional workload, then we recommend installing the proxy
on another machine on the same LAN segment. We recommend as a minimum, a dual-core
machine, with 2-4GB of RAM, but the exact system requirements depend on the number
of concurrent users and the size of your repository.

Create a system data source on the chosen machine to define the connection between the
proxy and the repository database (see Creating a Data Source to Access the Database on
page 30).

Insert the PowerDesigner software CD-ROM in the drive, and then click the I nstall
Power Designer Repository Proxy button.

Click Next to go to the license agreement page. Select the location where you are installing
the software, read the License Agreement, and then click the | Agreeradio button to accept
the terms of the agreement. If you click | DoNot Agree, you cannot proceed with the Setup
program.

Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

Click Next to go to the directory selection page. Accept the default installation directory or
choose another by clicking the Browse button.

Click Next to go to the current settings page to review your choices, and then click Next to
start copying files.

When setup is complete, a page is displayed with two checkboxes selected by default, to let
you start the proxy service and launch the configuration tool.

Click Finish to exit the wizard and open the Proxy Configuration dialog.
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Note: You must have write access on HKEY LOCAL MACHINE to change proxy
parameters. On a Windows 7 machine, you must launch the Proxy Configuration dialog by
right-clicking its icon and selecting Run as administrator. You can open the
configuration dialog at any time by navigating to the proxy installation directory and
launching pdproxyconfl6.exe.

8. Click New to create a new proxy connection instance, and enter the following parameters.

Parameter Value

Instance name Enter an appropriate name to identify the instance.

Data source Select the system data source you created for the repository from the list.
Note that the proxy cannot access user data sources.

User name Enter the user name used to connect to the repository database.

Password Enter the password used to connect to the repository database.

Bytes per char For non-Oracle unicode or multi-byte character set databases, specify the

bytes per character used by the database:

e 1-byte - [default] For SBCS (Single-Byte Character Set)

e 2-byte - For DBCS (Double-Byte Character Set)

¢ 3-byte - For Unicode or MBCS (Multi-Byte Character Set)

Port Enter the connection port of the server on which the proxy is installed and
which allows the client to communicate with the server using TCP/IP pro-
tocol. The default port number is 32999.

Log file Select the level of logging that you want to perfom and enter or browse to the
path to the log file in the Name field.

Cache Enter or browse to the path to the cache, and specify its maximum size. The
default is 300MB, which is generally sufficient for optimum proxy per-
formance.

Note: A single proxy server can provide simultaneous connections to multiple
PowerDesigner repositories of the same version. Click the New button to create an
additional instance.

. Click OK to complete your definition of proxy instances.

Users can now connect to the repository via the proxy by specifying the server name, port
number and instance name in a proxy repository definition (see Core Features Guide >
Modeling with PowerDesigner > Getting Started with PowerDesigner > Accessing the
Repository).

38

PowerDesigner



CHAPTER 5 Installing the PowerDesigner
Portal Server

The PowerDesigner Portal allows you to view the contents of your repository in your standard
web browser. The PowerDesigner installation disc includes database access and web
application layers that are required to browse your repository from the web, along with a
standard Apache Tomcat web server. Before beginning the installation, you should already
have created your repository database and have the DBMS user name and password to hand.

For maximum responsiveness, we recommend that you install the database access layer on the
same machine as your repository database, while the web application layer can be installed on
any appropriate machine. While each instance of the PowerDesigner Portal database access
layer can only communicate with a single repository database, a single web application
instance can communicate with multiple database access layers and provide a single point of
access for users browsing multiple repositories.

If the repository server is not a Windows server or is unable to support the additional workload,
then we recommend installing the PowerDesigner Portal on another machine on the same
LAN segment. We recommend as a minimum, a dual-core machine, with 2-4GB of RAM, but
the exact system requirements depend on the number of concurrent users and the size of your
repository.

Note: For information about using the PowerDesigner Portal, see Core Features Guide >
Storing, Sharing and Reporting on Models > The PowerDesigner Portal.

1. Insert the PowerDesigner software CD-ROM in the drive, and then click the I nstall
Power Designer Portal button.

The PowerDesigner Portal installation program opens to the welcome page.
2. Click Next to go to the license page, and select the type of license that you want to use:

e Trial - For evaluating PowerDesigner and the PowerDesigner Portal

e PowerDesigner Portal - For using the PowerDesigner Portal without allowing users
to edit object comments, descriptions, and annotations

¢ PowerDesigner Portal Composer - For allowing users to edit object comments,
descriptions, and annotations, which requires a separate license. If you select this
option, you will be prompted to specify the licence server that manages this license (see
Installing a License Serveron page 5).

3. Click Next to go to the license agreement page, and select the location where you are
installing the software. Read the License Agreement and click the | Agreeradio button to
accept the terms of the agreement. If you click | Do Not Agree, you cannot proceed with
the Setup program and you will have to cancel the install.

Installation Guide 39



CHAPTER 5: Installing the PowerDesigner Portal Server

Note: You can print the License Agreement from the Setup\Licenses directory on the
product CD.

4, Click Next to go to the web server page. If you have already installed one or more
PowerDesigner Portal servers, you can select the second option to install the web
application layer only. You will then be prompted to specify connection information for a
PowerDesigner Portal server to which it will connect. Setup suggests a location inwhich to
install the PowerDesigner Portal, which you can change by clicking the Browse button.

Sybase PowerDesigner Portal 16.5 @

Sybase® PowerDesigner Portal 16.5

Click the twpe of zetup wou prefer.

&

Installs the Database Access and 'Web Application layers

I " ‘web Application Layer anly
Fuor use with a PowerDesigner Portal Server already inztalled elzewhere

Destination Folder

C:\Program Files\SpbazetPowerD ezigner Portal 16 Browse...

SYBASE = &7ewm

5. Click Next to go to the application server page. By default, the installer will install a new
Tomcat Server. If you want to use one of the other supported servers, select it and specify
its location. Default sever ports may be provided that you must verify. At least one port is
required in order to create a connection profile and connect to the repository database.

Note: If you choose the WebLogic application server, you must deploy the archive
directory (by default, the weblogic openfolder directory inside your
PowerDesigner Portal installation directory) from your WebLogic Administrative
Console once the setup has completed.
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=
Sybase® PowerDesigner Portal 16.5

Sybase PowerDesigner Portal 16.5

Specify an application server to deploy the Portal.
By default, a new Tomcat server will be installed. Alternatively, vou can specify your own
application server location and port number.

{* Install new Tomeat 6.0

(™ Tomeat version B.x, 6.4 or 7.0
I (" JBoss wersion 4.x, By

(" EAServer version 6.2

" WeblLogiz 9.2 ar 10.3 [manual deployment)

‘wieb server configuration

Hitp port: 3030 Hitps port: 3443

Server Locatiorn

Cancel

SYBASE ~&ewm 0

6. Click Next to go to the JDK page. By default, a new JDK is installed. If you want to use an
existing JDK, deselect the check box and specify its location.

7. Click Next to go to:

« [for a full PowerDesigner Portal server install] The database parameters page lets you
enter the appropriate parameters for your database. If you select the Use Windows
Authentication checkbox, you will need to select the Thisaccount option on the L og
On tab of the web server service property sheet before starting the service.
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Sybase PowerDesigner Portal 16.5 @

Sybase® PowerDesigner Portal 16.5

Specify the databaze parameters for vour repositary. |f your repasgitory is stored in a DEMS ather
than Sybase SOL Anywhere or ASE, you must specify an appropriate JDBC driver jar file.

D atabase type: Sybasze SOL Anywhere -

JDBC driver clazs:  com.sybase.jdbe3.jdbe. SybDriver
I JDBL driver jar: jconnd.jar

Host: localhost Port: 2638
D atabase name:

User: dba Password:
[T UseWindows Authentication

Test

SYBASE' e wm"v < Back Cancel

[for an application layer only install] The connection information page of the
PowerDesigner Portal server lets you enter the appropriate parameters for connecting
to the existing repository web server instance. You must enter at least one port:

42

PowerDesigner




CHAPTER 5: Installing the PowerDesigner Portal Server

Sybase PowerDesigner Portal 16.5

=
Sybase® PowerDesigner Portal 16.5

Specify the connection information of the PowerDesigner Portal Server.

Fiemote PowerDesigner Portal Server name

I Remote PowerDesigner Portal Server HTTPS port

SYBASE 5 wﬁmuv < Back Cancel

8. Click Next to go to the information page which summarizes your choices.
9. Click Next to accept the current settings and start copying files.

The install begins. A progress box is displayed and Setup copies files to the destination
directory. When the setup is complete, one of the following pages appears depending on
your selection on the web server page:

« [PowerDesigner Portal server] The completion page opens with two check boxes
selected by default to let you:
« Start the PowerDesigner Portal Server service
* Open the PowerDesigner Portal Web page

» [web application layer] The completion page opens with a check box selected by
default to let you open the service configuration page and enter its account name and
password. Then you will have to start the service.

10. Click Finish to exit the wizard.
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Accessing the PowerDesigner Portal Web Site

You can start and stop the PowerDesigner Portal server and the associated service by
navigating to the server from your Start menu.

By default, these commands appear as sub-items of Programs > Sybase > Power Designer
Portal , and selecting the appropriate sub-item:

» Start the PowerDesigner Portal Server
 Start the PowerDesigner Portal Server Service
« Stop the PowerDesigner Portal Server
» Stop the PowerDesigner Portal Server Service

When the server is running (whether as a service or not), navigate to the following address:
http:// server-name: port-numbericmr

Where server-name is the name of the machine on which you have installed the
PowerDesigner Portal server, and port-number is the port specified during installation. Note
that cmr is the name of the PowerDesigner Portal program and is a required part of the
address.

The following screen will appear:

SﬁyBASE | PowerDesigner Portal E

Sign in to Sybase PowerDesigner Portal.
To sign in, select a connection profile, enter user name and password.

Connection profile: LOCAL -
Show profile information Advanced options

User name:

Lol
Password: “Viogon Help

For information about using the PowerDesigner Portal, see Core Features Guide > Storing,
Sharing and Reporting on Models > The PowerDesigner Portal.
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Installing the PowerDesigner Portal Server on UNIX

We do not provide support for installing any component of PowerDesigner on UNIX.
However, it is possible to manually deploy the PowerDesigner Portal to a UNIX environment
using this procedure.

This procedure requires that you install and configure the PowerDesigner Portal on a
Windows server in order to copy certain of the installation directories to your UNIX
installation.

Note: The PowerDesigner Portal is developed and tested with Tomcat on a Windows server,
using standard Java programing techniques, and does not take advantage of anything
proprietary to Tomcat or the Windows platform. As a result, the Portal application can be
manually installed onto other application servers and on other operating systems. For support
purposes, in the case of any reported concern, engineering will reproduce the issues under the
certified development and test environment to determine root cause, and if appropriate,
correct defects detected under that environment only.

1. Onyour UNIX server, install JDK 6.0 or higher, and set the JAVA HOME environment
variable to its path. For example:

export JAVA HOME=/usr/lib/jvm/java-6

2. Install Tomcat 5.5 or 6.0 and set the CATALINA HOME environment variable to its path.
For example:
export CATALINA HOME=../apache-tomcat-6.0.28

3. Create a new folder called CMR, and set the CMR_HOME environment variable to its path.
For example:
export CMR_HOME=../CMR

4. Copy the contents of the CMR HOME directory on your Windows environment to the
CMR_HOME directory on the UNIX server.

5. Extract the appropriate license library for your flavor of UNIX from CMR HOME/
license/lib/sylapi 2.2.0.7.zipt0 CMR HOME/license/lib.
6. Copy the cmr . war file from the CATALINA HOME/webapps directory on your

Windows environment to the CATALINA HOME/webapps directory on the UNIX
server.

7. Unzip cmr . war and edit the file cmr . war /WEB-INF/cmrhome . xm1 to remove the
content of the Path element, so that it reads <entry key="Path"></entry>.
Rezip cmrhome . xm1 into a new cmr . war and deploy the new cmr . war.

8. Ensure you have installed the necessary JDBC drivers to connect to your PowerDesigner
Repository, and that they can be found via the proper path statement.

9. Run CATALINA HOME/bin/startup.sh.
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Multiple PowerDesigner Portal Instances on One Server

We do not provide support for running multiple instances of the PowerDesigner Portal on a
single physical server. However, it is possible to manually configure your installation to do so
using this procedure.

1. Install the initial PowerDesigner Portal normally.
In this example, we will install the Portal to C: \Portal:

2. Create a second installation directory for the second instance of the Portal, and add a sub-
directory to hold the second instance of Tomcat.
In this example, we will create a second installation directory at C: \Portal?2

3. Install the second Tomcat or other server to C: \Portal2\Tomcat and specify a
different listening port.
In this example, we will use port number 3030 for the first Tomcat and 9090 for the second
instance

4, Copy C:\Portal\Tomcat\webapps\cmr.war to C:\Portal2\Tomcat
\webapps\cmr . war. Forthe remainder of this procedure, the file must be unzipped, as
it will be if Tomcat is running.

5. Copy the folders config, log, keystore,and license fromC:\PortaltoC:
\Portal2.

6. EditCc:\Portal2\Tomcat\webapps\cmr\WEB-INF\cmrhome.xml to
specify your new folder:
<entry key="Path">C:\Portal2</entry>

7. Clear C:\Portal2\Tomcat\work and restart Tomcat.

The URL for accessing the first PowerDesigner Portal ishttp://myserver: 3030/
cmr/ and the URL for the second is http://myserver: 9090/cmr/.

The new instance will initially point to the original database. You can change the database:
* By clicking the Advanced options link on the login page.
e Byediting C:\Portal2\config\repository.xml

Changing the Repository DBMS

If you decide to change the DBMS on which the repository database is stored, then you must
copy an appropriate JDBC driver to the PowerDesigner Portal 16\Tomcat
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\webapps\cmr \WEB-INF\1ib directory to allow the PowerDesigner Portal to connect
to the new database.
We recommend that you keep your original database running initially and that you change the

parameters on the PowerDesigner Portal Server Settings page, and use the Test Connection
button to confirm that you can connect to the new database.
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